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Tariffs causing chaos for newspapers
n	 By Sacha Biazzo
	 Columbia Journalism Review 
	 (Reprinted with permission)

Jeff Mayo had been prepar-
ing for this for weeks. In 
February, when President 

Donald Trump first announced 
a 25 percent tariff on imports 
from Mexico and Canada, 
Mayo, a third-generation 
newspaper printer in Sallisaw, 
Oklahoma, put in an order of 
Canadian paper. 

But by the time the tariffs 
actually went into effect – if 
only temporarily – his careful 
planning wasn’t of much use. 
As printers and manufactur-
ers scrambled to secure raw 
materials before the price went 
up, trucking shortages delayed 
shipments for everyone. 

“Even if we had the paper 
ready, we couldn’t get it on a 
truck,” Mayo told CJR, before 
the tariffs were once again 
suspended, until April 2. 

“Everyone’s trying to do the 
same thing.”

Canada has long been a 

major supplier of American 
newsprint – it now provides 
an estimated 80 percent of the 
paper used by US newspapers. 

A tariff would add a sig-
nificant burden to publishers 
already struggling with high 
costs of production and thin 
margins, and analysts say the 
mere looming threat of one has 
complicated life for printers. 

“There is no scenario under 
which this is cost-positive for 
the media industry,” said Brett 
House, a professor of profes-
sional practice at the Columbia 
Business School. “Almost 

anything that is done here is 
going to be increasing prices 
for newsprint.” 

John Galer, the publisher of 
the Journal-News in Hillsboro, 
Illinois, said the new tariffs 
represent more than just a 
financial setback. He publishes 
eight newspapers and prints 19 
other publications at his press, 
serving rural communities that 
often have no other dedicated 
source of news. 

His publications rely entire-
ly on Canadian newsprint, and 
he estimates a 25 percent tariff 

Newsprint 
tariffs exempt 
for now

Currently, President 
Trump’s tariffs on goods 
from many countries does 
not include newsprint.

Newsprint, which 
is a USMCA (United 
States-Mexico-Canada 
Agreement) compliant 
good, will continue to be 
exempt from the 25% tar-
iffs imposed on goods from 
Canada and Mexico and 
the additional 10% baseline 
tariff announced April 2.

The News/Media 
Alliance and the National 
Newspaper Association are 
continuing to monitor the 
situation.

Newsprint prices have 
increased over the last year. 
In February, the Woodward 
News and the Muskogee 
Phoenix cited the cost of 
newsprint as part of the 

See Newsprint, Page 3 See Exempt, Page 3

http://www.OkPress.com
http://www.Facebook.com/okpress
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From the President
By Shauna Belyeu

Publisher of The Eufaula Indian Journal • OPA President 2024-2025

OPA CALENDAR 
OF EVENTS

For more information  
on upcoming events visit 

okpress.com/events

Fri., April 25, 2025
OMC Webinar: “Reel Talk”: 
Leveraging Instagram to Boost 
Engagement and Awareness
	 A look at some of the current best 

practices on Instagram to engage 
with your audience and attract new 
users to your content. Presented by 
Tyson Bird, digital product manager 
for Texas Highways magazine.

Fri., May 9, 2025
Oklahoma Journalism  
Hall of Fame’s 55th Anniversary 
and 2025 Induction Class
	 Twenty longtime journalists and a 

prominent broadcast family will be 
among those honored at the 55th 
annual induction ceremony of the 
Oklahoma Journalism Hall of Fame.

	 NEW LOCATION: Due to a delay 
of the renovations in the Nigh 
University Center, the location of 
the Oklahoma Journalism Hall of 
Fame 55th anniversary induction 
reception, ceremony and dinner 
has been switched to the Edmond 
Conference Center, 2833 
Conference Dr, Edmond, OK. The 
times remain the same: 5 p.m. recep-
tion and 6-8 p.m. dinner. Dedication 
of the Oklahoma Journalism Hall of 
Fame Museum has been postponed.

Fri., June 6, 2025
ANNUAL CONVENTION
	 Join us for our annual OPA 

Convention at the Grand Casino 
Hotel & Resort in Shawnee.

Does that get your atten-
tion? It should.

A 79-year-old veteran’s 
storage building contents 
were sold without notice at 
a private sale. According to 
the account, it included his 
uniform, military accommo-
dations and other posses-
sions.

The owner claimed that 
they weren’t aware that they 
were required to file a notice.

This story highlights the 
importance of legal notice.

The legals are where the 
real news starts, long before 
the press conference or the 
Facebook posts.

Our legal departments 
are busy typing ordinances 
that passed in the local city 
council meeting that change 
zoning rules, a sheriff’s sale 
about to go up for a large 
parcel of land, or a stream 
water permit that would 
affect a lake.

Some of these stories may 
never make the front page 
until someone asks a few 
questions. That’s when the 
real stories emerge: a devel-
oper quietly lined up to buy, 
a county caught off guard by 
a mining company, a debate 
that hasn’t even started yet.

Guess where it all started? 
Not a press release. Not a 
press conference. A legal no-
tice. We need to do a better 
job of driving our readers to 
that section.

What if, every week, we 
pulled out one hidden gem 

from the legals and gave it a 
little room to shine?

Pair it with a directive to 
the actual legal page, and 
suddenly, we’ve made the 
fine print just a little bolder.

The Oklahoma Press As-
sociation wants to recognize 
your efforts and started a 
new monthly contest this 
year to recognizes a news 
story or series that:

•	 highlights the impact of a 
public notice or the omis-
sion of a public notice,

•	 helps readers understand a 
specific public notice, or

•	 explains the consequences 
of a public body’s failure 
to publish a notice in a 
legal newspaper.

A successful entry will 
usually result from the news-
room having read the public 
notices and recognizing a 

news or feature opportunity 
coming from the subject of 
a particular public notice. 
Stories should reference the 
notice.

The contest is not intend-
ed for editorials advocating 
for more public notice or 
opposing changes in public 
notice law.

One winner per month 
will receive a $100 check, 
a Certificate of Achieve-
ment and recognition in 
The Oklahoma Publisher. 
Annual Sweepstakes winner 
will receive a plaque, a $200 
check and recognition in The 
Publisher.

Your legal department 
could be your next beat. 

 Your next best story may 
be hiding in plain sight right 
between a zoning variance 
and a liquor license applica-
tion.

Veteran’s possessions sold  
at auction without notice

http://okpress.com/events
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reason for a reduction in the 
number of their print editions.

The Woodward News 
previously distributed print 
editions three days a week; it 
is now produced once a week, 
on Wednesday. However, said 
Sheila Gay, publisher of the 
Woodward News, daily con-
tent remains available on the 
website Woodwardnews.com.

“The cost of doing busi-
ness is going up dramatical-
ly, including a 40 percent 
increase in newsprint prices 
alone this year,” Gay wrote in 
an article for the newspaper.

“We must continue to 
make adjustments to stay 
viable in a changing world,” 
she wrote.

The increase in newsprint 
prices was also mentioned as 
a reason the Muskogee Phoe-
nix decreased the number of 
its print issues. 

Ed Choate, publisher of the 
Muskogee Phoenix, said they 
decreased its print editions 
from five to three per week.  

“This move will help 
us secure the future of the 
Phoenix so we are here for 
you and future generations,” 
Choate wrote in an article on 
February 22.

Choate also urged read-
ers to take advantage of the 
Phoenix’s online presence at 
muskogeephoenix.com.

would increase his costs by 
about twenty thousand dollars 
a year, forcing him to increase 
his prices. “I like to stay 
hopeful,” he said. “But right 
now, we’re all just waiting to 
see what happens next.” (Galer 
learned of the postponement of 
the tariffs from a text mes-
sage as we were speaking on 
the phone. “I don’t get it,” he 
muttered.)

The last time the US 
imposed tariffs on Canadian 
newsprint, the consequences 
were severe. In 2018, a single 
American paper manufac-
turer petitioned for duties on 

Canadian imports, arguing that 
unfair subsidies gave Canadian 
mills an advantage. 

The resulting tariffs sent 
newsprint prices soaring, 
forcing newspapers, especially 
smaller, independent publish-
ers, to make painful cuts. 

Some laid off staff. Others 
reduced page counts or elim-
inated print days altogether. 
A few publications shut down 
entirely.

The newspaper industry 
fought back, with the National 
Newspaper Association and 
other advocacy groups mobi-
lizing to overturn the tariffs. 

Legislators testified before 
the International Trade Com-
mission, warning that rising 
costs were accelerating the de-

cline of local journalism. After 
months of lobbying and legal 
challenges, the tariffs were 
lifted. But the damage had 
already been done. The price 
hikes never fully reversed, and 
many of the cuts newspapers 
made to stay afloat became 
permanent.

Now newspaper publishers 
like Mayo, whose company 
Cookson Hills Publishers 
prints eight newspapers serv-
ing mostly rural communities 
across eastern Oklahoma, find 
themselves stuck in limbo, 
forced to make financial de-
cisions for a future they can’t 
predict. 

“Unfortunately, it’s a wait-
ing game,” Mayo said.

Newsprint
Continued from Page 1

Exempt
Continued from Page 1

http://www.OkPress.com
mailto:news@OkPress.com
http://www.Facebook.com/OKPress
http://www.OkPress.com/LSP
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CHICKASAW NATION  
MEDIA RELATIONS

Loné Beasley
580-559-0921
lone.beasley@chickasaw.net
chickasaw.net

ETYPE SERVICES
Thad Swiderski
512-687-9055
thad@etypeservices.com
etypeservices.com

FEED THE CHILDREN
Carrie Snodgrass
(405) 213-9757
carrie.snodgrass@ 
	 feedthechildren.org
feedthechildren.org

GARVER
Mia Waddell
mewaddell@garverusa.com
garverusa.com

GRAND RIVER  
DAM AUTHORITY

Justin Alberty
918-256-5545
justin.alberty@grda.com
grda.com

MENTAL HEALTH  
ASSOCIATION  
OKLAHOMA

Adi McCasland
405-250-6331
amccasland@mhaok.org
mhaok.org

METRO  
CREATIVE  
GRAPHICS

Jennifer Steiner
800-223-1600
jsteiner@metro-email.com
metrocreativeconnection.com

OGE  
ENERGY CORP.

Christi Woodworth
405-553-3698
woodwoco@oge.com
oge.com

OKLAHOMA  
ASSOCIATION OF  
ELECTRIC  
COOPERATIVES, INC.

Chris Meyers
405-478-1455
cmeyers@oaec.coop
oaec.coop

OKLAHOMA BAR  
ASSOCIATION

Lori Rasmussen
405-416-7016
lorir@okbar.org
okbar.org

OKLAHOMA  
DEPARTMENT OF 
REHABILITATION  
SERVICES

Jody Harlan, Comm. Director
405-203-1318
jharlan@okdrs.gov
oklahoma.gov/okdrs.html

OKLAHOMA  
MEDIA CENTER

Rob Collins, Executive 
Director
405-205-9421
rob@oklahomamediacenter.
com
oklahomamediacenter.com

OKLAHOMA  
NATURAL GAS

Chad Previch
405-501-9509
Chad.Previch@onegas.com
oklahomanaturalgas.com

OKLAHOMA STATE 
SCHOOL BOARDS 
ASSOCIATION

Christy Watson, Comm. 
Director
405-528-3571
christyw@ossba.org
ossba.org

PHILLIPS  
THEOLOGICAL  
SEMINARY 

Kurt Gwartney
918-270-6470
kurt.gwartney@ptstulsa.edu
ptstulsa.edu

As we reported last month, 
new USPS bundling rules 
take effect July 1, 2025.

The Postal Service is 
eliminating the use of rubber 
bands and twine/string for 
securing bundles of flats for 
Periodical mailings. 

New standards require all 
bundles to have two or more 
cross-strapped bands or to be 
shrink-wrapped with one or 
more cross-strapped bands.

Mailings of 500 flat-sized 
pieces or fewer entered at the 
BMEU (Business Mail Entry 
Unit) are exempt from bundle 
preparation. Those mailings 
may be prepared loose in flat 
trays instead of bundles. 

Standards in sections 
203.4.5, 203.4.8 and 203.4.9 
have been revised to require 
all bundles of flats to have 
two or more cross-strapped 
bands or be shrink-wrapped 
with one or more cross-
strapped bands except for 
newspapers that are placed 
in a flat tray and entered as 
exceptional dispatch. These 
exceptional dispatch news-

papers can use only one strap 
around the middle to prevent 
damage. 

Publications with larger 
mailings should start search-
ing for some type of plastic 
strapping device.

Strapping devices range 
from fully automatic to 
semi-automatic to hand-op-
erated.

A Google search for “mail 
strapping equipment” shows a 
variety of devices. 

One of the least expensive 
options is mail tray strapping 
from Uline, available for 
$55 per carton. No tools are 
required with this option, the 
user simply tightens and cuts 
the strap.

Uline also offers a poly 
strapping kit that includes 
strapping, a tensioner/cutter 
tool and plastic buckles for 
$77.

Prices for fully automatic 
and semi-automatic devices 
begin at around $600 and go 
up from there.

Strapping equipment may be needed  
to comply with new postal bundling rule

This mail strapping tape requires no tools and is available from Uline. For 
more information see https://tinyurl.com/msvzkc76

A strapping kit, which includes strapping, tension cutter and buckles, is 
also available from Uline. For more information see https://tinyurl.com/
yh95bjby

For more options, use Google with search terms such 
as “Mail Strapping Equipment” or “Poly Strapping.”

mailto:lone.beasley@chickasaw.net
http://chickasaw.net
mailto:thad@etypeservices.com
http://etypeservices.com
http://feedthechildren.org
http://feedthechildren.org
mailto:justin.alberty@grda.com
http://grda.com
mailto:amccasland@mhaok.org
http://mhaok.org
mailto:jsteiner@metro-email.com
http://metrocreativeconnection.com
mailto:woodwoco@oge.com
http://oge.com
mailto:cmeyers@oaec.coop
mailto:lorir@okbar.org
http://okbar.org
mailto:jharlan@okdrs.gov
http://oklahoma.gov/okdrs.html
mailto:rob@oklahomamediacenter.com
mailto:rob@oklahomamediacenter.com
http://oklahomamediacenter.com
mailto:Chad.Previch@onegas.com
http://oklahomanaturalgas.com
mailto:christyw@ossba.org
http://ossba.org
mailto:kurt.gwartney@ptstulsa.edu
http://ptstulsa.edu
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FOI Oklahoma announces 2024-2025 award winners
An Oklahoma City tele-

vision station, two longtime 
hall-of-fame journalists, 
the retired Edmond school 
superintendent and the school 
board, and the Wagoner 
County clerk are among the 
honorees of Freedom of Infor-
mation (FOI) Oklahoma’s 
2024-25 awards.

“This year’s honorees 
epitomize the need for vig-
ilance in defending access 
to government records and 
meetings,” said Kurt Gwart-
ney, FOI Oklahoma’s execu-
tive director. 

The awards will be 
officially presented during 
the annual First Amendment 
Congress Oct. 8 at the First 
Amendment Center on the 
University of Central Oklaho-
ma campus in Edmond.

The Awards Committee 
that selected the awards 
consisted of FOI President 
Brianna Bailey, and board 
members Paul Monies, Bill 
Hickman and Joe Hight, who 
served as committee chair. 

Here are this year’s recip-
ients:

Marion Opala First 
Amendment Award:  
JOE CARTER

Joseph Carter has been 
consistent in his writing and 
talks about the need for jour-
nalistic ethics and their im-
portance for this democracy 
and the First Amendment. He 
has written that we are facing 
“a very dangerous period (in) 
American democracy.”

The 92-year-old has spent 
a lifetime as a journalist and 
writer and continues to be 
active in issues that face our 
country and journalism. He 
is also one of the leading 
experts on Will Rogers and 
continues to spread Rogers’ 

words of humor and wisdom 
about the United States.

Carter, an Oklahoma Jour-
nalism Hall of Fame mem-
ber, is an author and former 
reporter for United Press 
International. He is one of 
only two surviving reporters 
who covered the assassination 
of President John F. Kennedy 
in Dallas.

Ben Blackstock Award: 
KFOR-TV

FOI Oklahoma noted that 
KFOR is worthy of recogni-
tion for successfully fighting 
to protect the rights of jour-
nalists to attend open meet-
ings and hold public officials 
accountable. 

With the help of the 
Institute for Free Speech, 
KFOR filed a federal lawsuit 
after their journalists were 
excluded from Oklahoma 
State Board of Education 
meetings and relegated to an 
overflow room. KFOR jour-
nalists were also barred from 
news conferences with State 
Superintendent Ryan Walters’ 
press conferences following 
the meetings. 

A U.S. District Court judge 
approved an agreement in the 
lawsuit in December, ensur-
ing KFOR will have access to 
meetings and news confer-
ences. KFOR sought $17.91 
from the Oklahoma State 
Board of Education, symbolic 
of the year 1791, when the 
First Amendment to the U.S. 
Constitution was ratified. The 
defendants also agreed to pay 
KFOR’s attorney’s fees.

Sunshine Award:  
LORI HENDRICKS,  
WAGONER COUNTY CLERK

Wagoner County Clerk 
Lori Hendricks will be 
recognized for her proactive 

approach to public records 
access. Hendricks was first 
elected county clerk in 
Wagoner County in 2012 and 
ran unopposed in the 2024 
election to secure her fourth 
term in office.

“Hendricks is very respon-
sive to open records requests 
and provides a large amount 
of public information on the 
county web site, allowing 
citizens to access informa-
tion easily,” according to the 
nomination. 

Hendricks is a past pres-
ident of the County Clerks 
and Deputies Association of 
Oklahoma.

Special Commendation: 
Retired Edmond School 
Superintendent ANGELA 
GRUNEWALD and the  
EDMOND SCHOOL BOARD

When threatened with an 
accreditation downgrade and 
public challenges to its ad-
ministration, Edmond Super-
intendent Angela Grunewald 
and the school board refused 
to bow to demands from the 
state school superintendent  
to remove two best-selling 
books from their high school 
libraries.

After the school district 
filed a lawsuit, the Oklahoma 
Supreme Court ruled unani-
mously in favor of Edmond, 
saying the state education 
department and its superin-
tendent had overstepped their 
authority in seeking to ban 
the two books. The Edmond 
superintendent has since 
retired; however, she and the 
school board’s public stand 
was important against those 
who want to ban books and 
other materials. Since this 
ruling, efforts to ban books 
have been curtailed.

Bickham-Hale Service 
Award: LINDEL HUTSON

Lindel Hutson is a founder 
of FOI Oklahoma, a former 
president and continues to 
serve on its board.

Hutson is a longtime jour-
nalist who served as bureau 
chief of The Associated Press 
in Oklahoma and now serves 
on the Journalism Hall of 
Fame’s executive committee. 
He is also a member of the 
Oklahoma Journalism Hall 
of Fame. Hutson served as a 
United States Army journalist 
with NATO in Europe and in 
the U.S. He is also an accom-
plished artist. 

“Lindel is the epitome of 
what it means to serve an 
organization such as FOI 
Oklahoma,” said the nomina-
tion. “He is consistent in be-
ing active in the organization 
as a board member and on its 
committees. His wise counsel 
and understanding of FOI 
issues have helped guide this 
organization through difficult 
times. He has remained a 
steadfast supporter and leader 
of this organization for many 
years.”

Hutson received FOI Okla-
homa’s Opala Award in 2010.

Got News?
Share news about your 
newspaper with other 
OPA members! If you 
have a new hire, sales 
promotion, contest, or 
have received an award 
or honor tell us about it 
so we can put it in The 
Oklahoma Publisher.

Send your news or story ideas to

aanderson@okpress.com  
or call 405-499-0020

mailto:aanderson@okpress.com


6

M
ar

ch
 2

02
5 

| T
he

 O
kla

ho
m

a 
Pu

bli
sh

er

Russell M. Perry, founder 
and owner of Perry Publishing 
and Broadcasting, was recently 
recognized by the Oklahoma 
State Senate for his significant 
contributions to the state.

The Senate adopted Reso-
lution 13, authored by Senator 
Shane Jett, R-Shawnee, on 
April 7.

 Jett highlighted Perry’s 
groundbreaking role as the 
founder of The Black Chroni-
cle and the founder and owner 
of Perry Publishing & Broad-
casting, now Oklahoma's larg-
est independent radio group. 

Perry’s impact extends 
beyond media to his service on 
key state boards, including the 
Oklahoma Development Fi-
nance Authority, the Oklahoma 
Industrial Finance Authority, 
and the Oklahoma City Urban 
Renewal Authority, as well as 
numerous business and bank-
ing councils.

Perry was nominated in 
1999 by Governor Frank 
Keating to serve as the Okla-
homa Secretary of Commerce, 
making him the first African 
American in the state’s history 
to serve in this prestigious 
position.

However, his cabinet 

position was never officially 
confirmed by the Senate.

“By passing Senate Res-
olution 13 today, we are not 
only honoring Russell Perry’s 
immense contributions to 
Oklahoma but also affirming 
that he was more than qual-
ified, capable and deserving 

of the role of Secretary of 
Commerce,” Jett said. “Today 
we declare that Russell M. 
Perry is, indeed, an Oklahoma 
Secretary of Commerce and we 
thank him for his unwavering 
dedication, tireless service and 
profound impact on our state’s 
growth and success.”

Secretary Russell M. Perry 
was present for the Senate’s 
adoption of the resolution, 
along with family members, 
friends, Gov. Frank Keating 
and other distinguished guests.

Senator Shane Jett, right, reads a resolution officially confirming Russell M. Perry (seated), owner and publisher 
of The Black Chronicle, as a former Secretary of Commerce. Also present for the adoption of the resolution were 
family members, senators, Gov. Frank Keating and other guests.  Photo courtesy of LSB (Legislative Service 
Bureau) Photography.

Perry recognized for contributions to the state

New Edition of Tour of 
Lawton Murals available

The latest edition of the 
Tour of Lawton Murals 2025 
maps/booklet, sponsored in 
part by The Lawton Constitu-
tion, is now available.

Now in its fifth edition, the 
booklet has grown from 44 art 
pieces to 79. 

Produced by The Lawton 
Constitution, other sponsors 
include the Lawton Economic 
Development Corporation and 
the Lawton/Fort Sill Chamber 
of Commerce.

The 2025 tour book features 
the work of artists Darry and 
Terry Shaw, Robert Peterson, 
Justin Hackney, Shaila Ramos 
(Red Elk), Danny Niedo and 
Dallas Morgandale. The book-
let also includes a fold-out 
map in the center.

A mural trivia game, spon-
sored by The Constitution and 
Chamber of Commerce, offers 
players a chance to win a $50 
gift card to area businesses.

The Tour of Lawton Murals 2025 booklet, produced by The Lawton Constitution, 
is available at the newspaper office as well as Lawton’s Chamber of Commerce 
offices.
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The U.S. Postal Service 
filed notice on April 9 of mail-
ing services price increases.

The proposed increase for 
Periodicals averages 9.4%. 
First-Class Forever stamps 
would increase by five cents, 
from 73 to 78 cents.

If approved by the gover-
nors of the Postal Service, the 
new rates would take effect 
July 13.

The National Newspaper 
Association, along with the en-
tire mailing industry, has called 
for the USPS Board of Gover-
nors to pause the ‘Delivering 
for America’ plan, especially 
with regard to the large rate 

increase that has been under 
development. 

NNA said that over the last 
month thousands of messages 
have been sent to the Chair of 
the Board of Governors and 
leaders  of House and Senate 
oversight committees calling 
for a pause.

A notice filed with the 
Postal Regulatory Commission 
(PRC) said the Postal Service 
has approximately 9.4 percent-
age points of pricing authority 
for the Periodicals class.

“ The Governors have 
determined to use virtually all 
of this authority,” the notice 
states. 

With five vacancies on the 
USPS Board of Governors and 
the resignation of Postmaster 
General Louise DeJoy, NNA 
said it believes these type of 
decisions should not be made 
until the Board of Governors is 
at full strength and new leader-
ship has been installed.

DeJoy resigned March 24 
after nearly five years in the 
position.

Deputy Postmaster General 
Doug Tulino has taken over 
the position until the Postal 
Service Board of Governors 
names a permanent replace-
ment.

USPS announces plans to increase 
rate of Periodical mailings by 9.4% 

By John Foust
Greensboro, NC

My grandmother Martha 
lived in Wilson, which is in 
eastern North Carolina. As 
a widow, she remarried later 
in life to a widower named 
Herman. I was in my twen-
ties then, and it was a special 
privilege to see those sweet 
lovebirds spend their final 
years together. 

A few years after they 
married, they moved to a 
retirement community in 
Durham, about thirty minutes 
away from Raleigh, where I 
was living. 

Being so close, I visited 
them as often as I could. I 
remember calling before 
one visit to ask if there was 
anything they needed. Her-
man said he needed a can 
of Barbasol shaving cream 
from a particular drug store in 
Wilson. I was happy to do that 
and, although I mentioned that 
Barbasol was sold everywhere, 
he insisted that it had to come 
from that favorite drugstore. 

I ended up buying the shav-
ing cream in Raleigh and took 
it to him, never letting on that 
it came from a different store. 
Everything worked out fine. 

Brand loyalty is a power-
ful force. For years, Herman 
was loyal to Barbasol shaving 
cream and that drug store. He 
wasn’t unpleasant about it at 
all; that was simply his choice. 

Like Herman, we all have 
loyalties to specific brands. 
Some of us wouldn’t think of 
driving anything but a Toyota. 
Some always have Cheerios in 
their kitchen cabinet. And oth-
ers will drive past two grocery 
stores to get to the store they 
like best. 

Branding is a big topic that 
has inspired countless books, 
articles, seminars and lectures. 
But for our purposes today, 
let’s narrow it down to one 

question: How can you deal 
with an advertiser who doesn’t 
consider your newspaper 
because of a strong loyalty to 
another advertising choice? 

Franklin, who has been 
a sales manager for many 
years, told me about his team’s 
approach. “We acknowledge 
that loyalty runs deep in the 
advertising industry. We have 
plenty of advertisers who are 
loyal to us, so we understand 
how some people are loyal to 
others. Maybe a business has 
had good results running ads 
somewhere else. Maybe they 
have a long-term relationship 
with the other ad department. 
Or maybe it’s a comfortable 
habit or a resistance to the 
perceived difficulty of setting 
a new course. 

“When we hit that brick 
wall with a potential advertis-

er, we do two things,” Franklin 
explained. “First, we develop 
a plan to stay in touch. We 
don’t become a pest, we just 
reach out to them every now 
and then to keep ourselves 
top-of-mind. We might send 
information about a relevant 
special section or even an 
interesting article about their 
favorite team. 

“The second thing is to 
watch carefully for signs 
of change in their business, 
because change may indicate 
a willingness to consider new 
ideas. Is there new ownership 
or management? Is there a 
new ad manager? Are they 
planning to open a new home 
office or store location? Big 
or small, a hint of change 
may open the door for a sales 
appointment.”
©Copyright 2024 by John Foust. All rights 
reserved. John Foust has conducted training 
programs for thousands of newspaper adver-
tising professionals. Many ad departments are 
using his training videos to save time and get 
quick results from in-house training. Email for 
information: john@johnfoust.com

Brand loyalty is a powerful force

The location of the 
Oklahoma Journalism Hall 
of Fame 55th anniversary 
induction reception, cere-
mony and dinner has been 
switched to the Edmond 
Conference Center at 2833 
Conference Dr., in Edmond 
due to a delay of the renova-
tions in the Nigh University 
Center.

The times remain the 
same: 5 p.m. reception and 
6-8 p.m. dinner on May 9. 
The change of venue also 
postpones the dedication of 
the Oklahoma Journalism 
Hall of Fame Museum. 
That time and date will be 
announced later.

New Location for 
Oklahoma Journalism 
Hall of Fame banquet

How can you deal with an advertiser who doesn’t consider 
your newspaper because of a strong loyalty to another 
advertising choice? 
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Learn the best practices for Public Notices at 
okpress.com/public-notice-training
The Oklahoma Press Association offers three videos that describe and 
illustrate the standards and best practices for publication of notices 
along with downloadable material.

The Thomas Tribune 
recently welcomed Rylee 
Chamberlain to the staff as 
reporter, composition and 
other duties.

After graduating from 
high school in 2020, Cham-
berlain attended South-
western Oklahoma State 
University in Weatherford, 
graduating in May 2024.

During her time in 
college, she worked as a 
resident advisor.

After graduating, she 
stayed in Weatherford, 
working at various other 
publications, before ac-
cepting the position at The 
Thomas Tribune.

“I’m happy to be work-
ing toward becoming a part 
of the lovely community 
that’s been built in Thom-
as,” Chamberlain said.

Chamberlain will be 
helping cover the day-to-day 
operations of the newspa-
per when Editor/Publisher 
Arianna Parkinson is on 
maternity leave, sometime 
in May.

Tribune hires 
new reporter

OU Student Media re-
cently received a $100,000 
pledge to the OU Daily from 
an anonymous donor to honor 
Becky Willis.

The Becky Willis Memori-
al Fund for News Leadership 
embodies the values of her 
spouse, Jack Willis. 

The endowed fund, 
launched last year, now will 
generate a $1,250 scholarship 
awarded each fall and spring 

to the Daily’s news managing 
editor.

Jack is a former OU Daily 
adviser. He worked at the 
Muskogee Daily Phoenix and 
Times Democrat for 19 years 
rising to the role of editor. 

Becky worked for sev-
eral financial institutions 
and became vice president 
before the couple moved to 
Norman in 1993. In Norman, 
she worked in sales before 

finishing her career as head of 
human resources and office 
manager. 

Jack served as adviser to 
the OU Daily through his re-
tirement in 2007, after which 
they moved to Edmond. 

He was inducted into the 
Oklahoma Journalism Hall of 
Fame in 2001.

Becky died March 18, 
2024, at age 71.

OU Daily receives $100,000 Donation

Two ODOC prison publications named  
finalists for national journalism award

 The Oklahoma Depart-
ment of Corrections proudly 
announces that The Warrior 
Standard and The Mabel 
Bassett Balance have been 
nominated as 2025 Stillwater 
Award recipients in the New 
Prison Publication category.

The Stillwater Awards, 
now in their second year, are 
presented by the Society of 
Professional Journalists and the 
Prison Journalism Project to 
recognize outstanding journal-
ism created within the incar-
cerated community. Finalists 
are selected from across the 
country, and placements for 
each category – first, second, 
and third – will be revealed 
during a live virtual ceremony.

“This nomination is a tre-
mendous honor for the writers, 
editors and staff who dedicate 
their time and talent to these 
publications,” said Nicole 
Flemming, chief of Offender 
Advocacy. “It’s a powerful 

reminder that storytelling can 
inspire change, even from be-
hind the walls of a correctional 
facility.”

The Warrior Standard is 
produced at Eddie Warrior 
Correctional Center in Taft, 
Okla., while The Mabel Bassett 
Balance originates from Mabel 
Bassett Correctional Center in 
McLoud, Okla. Both publica-
tions emerged from an 11-week 
journalism workshop initiated 
in June 2024 through a part-
nership between Poetic Justice 
and the national nonprofit 
Prison Journalism Project. This 
initiative provided participants 

with training and support to 
create community newspapers 
within their facilities.

The 2025 Stillwater Awards 
virtual ceremony will take 
place at 7 p.m. Thursday, May 
8. Family members, support-
ers and the public are invited 
to attend via Zoom. For more 
information and to register to 
attend the award ceremony, 
visit https://www.spj.org/still-
water-awards-2024-winners/.

To view all editions of the 
EWCC and MBCC newspa-
pers, visit https://www.poetic-
justice.org/prison-journalism.
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The March 26 edition of 
the Yukon Progress contained 
the headline in its sports sec-
tion, “Interviewing a Legend,” 
that lured readers to learn who 
the story was about.

While the story was about 
University of Oklahoma and 
NFL football superstar “Little 
Joe” Washington, it was even 
more intriguing to learn it was 
written by Yukon Progress cub 
reporter Zachary Jordan.

The questions the 11-year-
old reporter asked garnered 
genuine answers from Wash-
ington. Among them were: 
Why did you pick OU? What 
do you think about OU joining 
the SEC? Jordan even got a 
response when he asked if he 
was willing to talk about the 
Washington name change from 
Redskins (the team he played 
on that won the Super Bowl in 
1982) to the Commanders.

Perhaps the most import-
ant exchange came when the 
young reporter asked “Little 
Joe” what advice he would 
give young kids about sports.

The legend’s response 
proved to be good advice for 
children and adults.

 “When you’re a kid… 
you should be a kid.  Do kid 
things. Always be considerate 
of all the other kids that are 
around you. 

“Kids should be protective 
of other kids. Whenever you 
see something that isn’t right, 
take a stand. Cause you know 
right from wrong. You may 
not think so, but you really do.

“Enjoy sports and have 
fun. Learn to play a musical 
instrument... I didn’t do that 
and wish I had. 

“Help your parents around 
the house. Take out the trash 
and clean up after yourself. 

“Also, read a lot. Read a lot 
and play a lot.”

Jordan has been taking pic-
tures and interviewing famous 
people like U.S. Sen. James 
Lankford, U.S. Rep. Stepha-
nie Bice, former Gov. Frank 
Keating, football stars Brian 
Bosworth, Greg Pruitt, Jason 
White and Billy Sims for the 
Yukon Progress since he was 9 
years old.

At the conclusion of the 
Joe Washington story was 
a picture of Jordan with his 
camera on the sidelines of 
a football field. The cutline 
read, “Whether on the field or 
in the halls of Congress, you 
can depend on Zachary Jordan 
asking questions and taking 
pictures.”

Tom Firme has the unique 
title of sports/managing editor 
at the Poteau Daily News. 
With that you will find his 
byline on everything from 
hard news and feature stories 
on the front page, plus lots of 
pictures throughout the paper 
and a wide array of sports 
stories and pictures.

A recent front-page story 
by Firme titled “Why athletic 
facilities matter for schools” 

did an excellent job of com-
bining both sports and news.

The story pointed out that 
just like colleges, Oklahoma 
high schools are now having 
to compete to keep their ath-
letes from transferring to other 
schools and attracting those 
who want to transfer from 
another high school to come to 
places like Poteau.

Like at colleges, facilities 
are a big part of the equation. 

Firme quoted a Poteau 
school official saying, “Facili-
ties are a huge thing. You want 
students to come to school, 
and now you’re competing 
with that level of transfer, you 
want them to come to a school 
with pride.”

From its news coverage to 
advertising content, The Pa-
per in Pryor uses every square 
inch of available space to 
inform the people in northeast 
Oklahoma.

It is common for newspa-
pers to have several front-page 
stories, but the deeper you go 
inside the more stories appear 
to only be there to fill space on 
pages that are void of advertis-
ing – but not The Paper. 

Seldom will readers of 
The Paper see stories on its 
front page. Instead, it serves 
as a map to the treasure-trove 
of local stories on the inside 
pages.  

A typical 28-page tabloid 
size edition of The Paper con-
tains dozens of local stories, 
excellent use of news briefs 
and more than 50 display ads!

Joe Lansden has been pub-
lishing The Herald-Democrat, 
the only newspaper in Beaver 
County, for decades. In every 
edition you will find his per-
sonal column, “One Chippers 
Point of View By Joe.”

The column gets its name 
because Beaver, Oklahoma, 
is the Cow Chip Throwing 
Capital of the World. Each 
year competitors gather in 

the Oklahoma panhandle 
community to see who can 
throw a cow chip (dried pile of 
manure) the farthest.

The Thomas Tribune does 
a great job getting sports 
page sponsors. Each edition 
contains around 30 sports 
sponsors and an invitation for 
more. 

“Support the Thomas 
Terriers & become a SPORTS 
PAGE SPONSOR! Sponsor-
ships help send the Tribune 
sportswriter to the games for 
coverage & all pictures in 
print and social media. 580-
661-3524.”

TOP FIVE HEADLINES:
5.	 Relying on Uncle Sam   

– The Journal Record 

4. 	 Where there’s a will, 
there’s a way  
– Durant Democrat

3.	 Trapped by flames     
– Enid News & Eagle

2.	 At The Big House  
 – The Lincoln  
County News

1.	 Water rate hike: In a 
pickle over nickel    
– The Paper (Pryor)

Looking  
Them Over
by Rod Serfoss

rserfoss@okpress.com

Cub reporter masters art of writing at Yukon Progress

OPA Business Consultant Rod  
Serfoss looks over OPA member 
publications for “Looking Them Over,” 
a monthly column. To contact  
Serfoss, email rserfoss@okpress.com.

Editor’s Note: � is is the second in 
a series of articles about candidates 
for Yukon Public Schools’ Board of 
Education election. Read more in 
this Saturday’s edition.

By Conrad Dudderar
Associate Editor

Candidates in Yukon Public 
Schools’ Board of Education elec-
tion share their views in today’s 
edition on challenges facing the dis-
trict – and how they would address 
them.

Tony Yanda and incumbent Cody 
Sanders are vying for the O�  ce #5 
seat, with the winner claiming the 
next � ve-year term on the � ve-
member YPS governing board.

Yanda is a construction executive 
with � e Boldt Company. Sand-
ers is an Edmond � re� ghter and 
small business owner. Both men 
have children attending the Yukon 
school district.

Although YPS is divided into � ve 
school board posts, all registered 
voters within district boundaries 
will be eligible to cast ballots.

Election Day is next Tuesday, 
April 1, with polling places open 
from 7 a.m. to 7 p.m. for voters to 

cast their ballots.
Early voting will be 8 a.m. to 

6 p.m. this � ursday and Fri-
day, March 27-28 at the Canadian 
County Election Board in El Reno.

ON THE ISSUES
Yanda believes top issues for the 

Yukon school district are educator 
support, retention and recruitment, 
overcrowding of schools and infra-
structure, and lack of funding and 
resources.

� is list last came from input he’s 

heard from many conversations 
with the district’s parents, educa-
tors and sta�  – and results of a com-
munity survey last fall as part of the 
YPS superintendent search process. 

Yanda, whose father Anton V. 
Yanda III served on the YPS Board 
from 2001-25, will advocate for in-
creased teacher pay and resources 
as well as professional development 
opportunities.

“I will work with our board, ad-
ministration and community part-
ners to develop innovative teacher 
retention and retainment programs 
to ensure we are providing them 
with an environment in which they 
will thrive as this will only bene� t 
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Weather delays SH-4 project completion
‘Mid- to late-summer’ for phase 2, ODOT spox says

By Conrad Dudderar
Associate Editor

Motorists traveling 
State Highway 4 in 
Yukon city limits will 
have to wait several 
months longer than 
expected for construc-
tion to conclude while 
work also continues 
north in Oklahoma 
City limits.

Last fall, the Okla-
homa Department of 
Transportation had 
estimated the second 
phase of the project 
would be completed 
this May. Phase two 
is along a two-mile 
section of SH-4 from 
Main Street (SH-66) 
north past Wagner 
Road to the North Ca-
nadian River.

ODOT spokesman 
Bryce Boyer provided 
an update a� er speak-
ing with project engi-
neers, indicating con-
tractor Schwarz Paving 
“ran into some weath-
er delays” in recent 
months that temporar-
ily stalled progress.

“Weather permit-
ting, assuming spring 
doesn’t derail every-

thing, it should be a 
mid- to late-summer 
completion on that 
phase-two project,” 
Boyer said.

ODOT does not 
penalize its contrac-
tors if bad weather 
causes a project to ex-
tend beyond the initial 
agreed-upon construc-
tion timeline.

“As long as it’s some-

thing out of their con-
trol,” Boyer explained. 
“If we can � nd a con-
tractor that controlled 
the weather, they’re 
going to be on ev-
ery project. Until that 
point, I don’t think 
we can really penalize 
them for it.”

Schwarz Paving 
started phase two in 
October 2023, with 

tra�  c being narrowed 
to one lane in each 
direction within the 
project boundaries.

As with the � rst 
phase, contractor 
crews are reconstruct-
ing and widening SH-4 
to provide safer pas-
sage for drivers.

� e state roadway 

See SH-4 Page 3A

Hungry hordes get their ‘Taste’
600-plus attend 24th annual Yukon food festival
It was literally “standing 

room only” as guests had 
their taste buds tickled � urs-
day, March 20 during the 24th 
Annual Taste of Yukon inside 
the Dale Robertson Center, 
1200 Lakeshore Drive.

� ere was no stopping the 
hungry hordes as more than 
600 people piled in and � lled 
their bellies. � e food was 
abundant, and faces were full 
of satis� ed expressions as the 
citizens of Yukon were treated 
to this ultimate tasting event.

More than 20 local eater-
ies provided samples of their 
signature dishes at the 2025 
Taste of Yukon presented by 
Yukon Parks & Recreation.

Featured vendors were City 
Bites, Green Chile Kitchen, 
Marco’s Pizza, Alfredo’s Mexi-
can Café, Pizza Hut, � e Big 
Easy New Orleans Cafe, Ei-
leen’s Colossal Cookies, � e 
Baked Bear, Nothing Bundt 
Cakes, Raising Cane’s Chick-
en Fingers, Bad Brad’s Bar-B-
Q, Earl’s Rib Palace, Del Taco, 
Hawaiian Bros. Island Grill, 
� e Lokal Yukon, Dave’s Hot 
Chicken, Freddy’s Frozen 
Custard and Steakburgers, 
Interurban, Johnny Carino’s, 
and Hideaway Pizza.

Attendees cast their votes 
on which restaurant they 
thought o� ered the best taste 
– from appetizers to main 

courses to desserts – and had 
the nicest booth.

� e competition was � erce 
as each vendor brought their 
A-Game.

� e top three � nishers in 
the “Best Decorated Booth” 
category were:
• 1st – Earl’s Rib Palace
• 2nd – � e Big Easy New Or-
leans Cafe
• 3rd – Bad Brad’s Bar-B-Q

� e coveted “Best Taste” 
winners were:
• 1st – � e Lokal Yukon
• 2nd – Hawaiian Bros. Island 
Grill
• 3rd – Earl’s Rib Palace

Kesha Carson and her daughter Scarlett sample a 
sandwich from Earl’s Rib Palace during the 24th An-
nual Taste of Yukon inside the Dale Robertson Cen-
ter. “I thought it was great. We really enjoyed it,” 
Carson said.  (Photo by Jason Nieuwenhuis)See Taste of Yukon Page 4A

YPS board contenders talk candidly about issues 
All district voters eligible for O�  ce #5 election

See YPS Board Page 5A
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Terrier pitcher Jace Schulz brings the heat as he 
helped the team to a win over Jay last week in the 
Broken Bow Festival.

Lady Terrier shortstop Tynlee Stinson catches the line drive to force an out and end the inning against 
Cordell. The Lady Terriers will be back in action after the spring break last week. 

Thomas Junior High slow pitch pitcher Hynlee Hart catches a ball that 
was hit to her for an out in a game against Cordell.

Thomas JH baseball catcher Charter Lisle steps 
out from his catcher’s spot to catch a ball for an 
out against Fairview.

Terrier JH first baseman Stryker Bennett makes a nice stretch to make 
the catch and give Fariview an out to end the inning.

Thomas baseball player Carter Frymire slides into home plate to score 
a run for the Terriers in their win against Ardmore in the Broken 
Bow Festival.

Thomas senior baseball player Brodie Willis gets set to bunt the ball in a game against Ardmore last week 
during the Broken Bow Festival.

Thomas baseball, softball in full swing

mailto:rserfoss@okpress.com
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is just one of the benefits of being a member of the Oklahoma Press 
Association’s Legal Services Plan. Remove the worry of needing  
professional advice by enrolling today. For more information contact:

OKLAHOMA PRESS ASSOCIATION’S 
LEGAL SERVICES PLAN 

1-888-815-2672 or 405-499-0020

OPA Computer Consultant Wilma 
Newby’s column is brought to you by 
the Oklahoma Advertising Network 
(OAN). For more information on the 
OAN program, contact Oklahoma 
Press Service at (405) 499-0020.

A clean web browser is 
good for the health of your 
computer.

Webpage browser cache 
and cookies need to be cleared 
in all browsers on all comput-
ers every now and then. All 
those files on the web servers 
use your computer’s hard 
drive space to store that infor-
mation – and it may not be in 
the computer’s best interest.

The first time you open a 
page on a browser, files such 
as images, fonts and code are 
stored. This local storage helps 
the page re-appear a little 
faster next time you visit. 

When the page is reloaded 
the browser first checks the 
cache for an existing page 
version, but if the website has 
been updated since the last 
visit, it will download and 
cache whatever new informa-
tion it discovers as missing or 
outdated. Websites can also 
set expiration dates for cached 
files, forcing the browser to 
download the latest version 
and update the cache.

Caching differs from 
cookies, which are small bits 
of information created by 
sites visited. Cookies are what 
the browser saves to person-
alize your experience, such 
as logins, site preferences or 
shopping carts. 

Cache is also different from 

browser 
history, 
which is 
simply a 
record of 
all the sites visited and when 
they were visited. 

Internet  cookies are 
small text files that identify 
the computer to the websites 
servers. They can contain user 
names and passwords

  A computer’s data is 
labeled with an ID unique 
to that computer. When the 
cookie is exchanged between 
the computer and the network 
server, the server reads the ID 
and knows what information 
to specifically serve for that 
computer. Data collected from 
your online activity is how 
advertisers deliver targeted 
ads to individual users.

Cookies store how many 
pages were clicked, what was 
clicked, and user name and 
passwords used on the page, 
as well as language preferenc-
es. Shopping cart preferences 
are also stored in case the user 
wants to reopen the page and 
still have items in the cart. 
Cookies also track how long 
the site is open. 

Hackers can sometimes use 
this information for identity 
theft and other malicious acts. 
Depending on where they 
come from, some cookies may 
potentially be more of a threat 
than others.

To maintain your web 
browser, look for Settings in 
the web browser menu located 

under the three parallel bars 
at the upper right corner 

of the browser window. 
Open the settings and 

look for Privacy & Securi-
ty. Go slow and read the 
page carefully. Look for 
Advanced buttons that allow 

more control over what is 
deleted when clearing cookies.  
For example, you may be able 
to clear cookies without losing 
saved passwords for sites.

To remove persistent track-
ing cookie infestations and 
more malicious types created 
by hackers, enlist the help of a 
premium antivirus software. 

For even more protection 
try hiding the computer’s web 
use by using a VPN (virtu-
al private network). VPNs 
tunnel the web connection to a 
remote server that poses as the 
local computer. Cookies will 
then be labeled for that remote 
server instead of the local 
computer. 

Many browsers can be set 
to clear cookies – and to block 
some types of cookies – each 
time the program is closed. 

IMPORTING TEXT 
Cleaning text before im-

porting it into any page layout 
program is good practice.

Apple computers have a 
great program for this called 
Text Edit. It renders any email 
text or website text to a plain 
text file that can then be placed 
into a layout program without 
internet artifacts such as URL 
active lines and little square 

boxes in the text. To use, just 
copy and paste the text to Text 
Edit then go to Format > Make 
Plain Text. Now save the file 
to be imported or copy the 
text from the text edit file and 
paste it in the layout file.

Text Edit may not show on 
the dock so look for it in the 
Applications folder. It can be 
pinned to the dock by right 
clicking on it once it’s open 
and choosing Options > Keep 
in Dock. 

Windows computers can 
use WordPad, although Mic-
rosoft says it is being removed 
from all editions of Windows 
11. If you’re still on Windows 
10, look for WordPad with the 
search bar in the task manager. 

To use, copy your text and 
paste it into WordPad. Then 
click File > Save As. Select 
where to save the file and 
name it. 

In the Save as type drop 
down menu, choose Rich Text 
Format (*.rtf) and click Save. 
Then import the file into the 
layout program (in InDesign it 
is File > Place).

Treating all files that come 
from Internet web pages or 
email this way will solve a lot 
of problems on deadline days. 

InDesign bases the format 
of the text on what defaults are 
set up for the text tool or text 
block when it flows onto the 
page. 

Make sure the default for 
the text tool to place text 
is Paragraph and Character 
styles.

To check, click on the text 
tool without a flashing “I” 
beam on the page and look at 
the styles. Highlight the ones 
to be the default for the pro-
gram, then bring in the text.

Cookies and cache cleanup for your computer
Computer Notes

from the road
by Wilma Newby

wnewby@okpress.com
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Remembering our friends 
& colleagues who died the 

previous year.
Major General Donald  

Forrest Ferrell 
March 15, 2024

Dorothy Dell Butler Welsh 
March 25, 2024

Carolyn Nell (Meyers) 
McBride 

March 28, 2024

Max Nichols 
March 31, 2024

Larry Paul Adler 
April 10, 2024

Jim East 
April 16, 2024

Edward ‘Edd’ Harold Bellatti 
 April 26, 2024

DEATHS
ANITA FAYE  
REDING, general manager and 
editor of the Stigler News-Sen-
tinel, died March 10, 2025. 
She was 68. 

Reding was born December 
8, 1956, in Pryor. She grew up 
in Oklahoma and Arkansas, 
graduating from high school in 
Pryor.  She attended Oklahoma 
Baptist University, graduat-
ing in 1979 with a bachelor’s 
degree in journalism.

Reding worked more than 

25 years in the newspaper in-
dustry with stops at the South-
west Times Record, Pine Bluff 
Commercial, Skiatook Journal, 
Muskogee Phoenix, Northwest 
Arkansas Democrat-Gazette 
and the Stigler News-Sentinel. 
She was named Small Busi-
ness Journalist of the year in 
2007 by the Arkansas Division 
of the Small Business Admin-
istration. 

She went to work at the 
Stigler News-Sentinel in 2014. 
She briefly left in 2018 to 

live near her family but, after 
five months, returned to the 
Sentinel. She served as the 
News-Sentinel general man-
ager and editor since October 
2023.

Reding is survived by her 
mother, Juanita Reding of 
Stigler; brother Danny Reding 
of Lowell, Arkansas; nephew 
Brian Reding of Bentonville, 
Arkansas; niece Laura Gehrke 
of Elkins, Arkansas; and a 
great-niece and great-nephew.

SHERRY GAYLE 
MUCHMORE, a columnist 
for the Ponca City News, died 
April 8, 2025. She was 79.

Sherry was born March 8, 
1946, in Winnfield, Louisiana. 
She graduated from Northwest 
Classen in Oklahoma City in 
1964.

Her career included serving 

as office manager for the Der-
ryberry law firm and assistant 
to Oklahoma Press Associa-
tion executive secretary Ben 
Blackstock.

After moving to Ponca 
City, she wrote a column, The 
Neighborhood Chef, for The 
Ponca City News. She was ap-

pointed to the Oklahoma His-
torical Society for six years.

Sherry is survived by her 
husband Tom Muchmore, 
of the home in Ponca City; 
and her children: Blaine 
Lewis, Laura McClatchey, 
Pat Muchmore and Shannon 
Muchmore; and her sister Tina 
Fausett of Oklahoma City.

JEFFREY JAY KALEY, a 
former reporter at The Duncan 
Banner, died April 7, 2025. He 
was 73.

Kaley was born June 7, 
1951, in Robinson, Illinois. 
After graduating from high 
school he embarked on a ca-
reer in journalism.

His first job as a writer was 
as a sports editor for the Rob-
inson (Ill.) Daily News.

In September 1985, Kaley 
joined the staff of The Duncan 
Daily Banner. He served there 
as sports editor for 17 years 
before transitioning to news. 

Kaley became editor and 
general manager of The 
Banner’s sister newspaper, the 
Waurika News-Democrat, in 
2005. He held that position for 
nine years. 

While working at the 
Banner and News-Democrat, 
Kaley received many awards 
including Columnist of the 
Year in the Best of CNHI 
contest. The Banner and 
News-Democrat each won four 
OPA Sequoyah Awards while 
he was on staff.

Kaley also worked at the 
Stillwater News Press and after 

retiring from full-time work 
in 2015, he continued some 
freelance work for The Lawton 
Constitution and Oklahoma 
Living.

He served for 30 years on 
the selection committee for the 
Duncan Athletic Hall of Fame 
and was inducted into the hall 
of fame in 1985.

Kaley is survived by his 
wife Karen of the home; sons 
Anthony Morris of Portland, 
Oregon, and Chris Morris of 
Norman; brother Chris Kaley 
of Missoula, Montana; and two 
grandchildren. 
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Column Winner: 
JEFF MULLIN

Enid News & Eagle

Becoming an American  
never really has been easy

We’ve all read the words, heard them recited, likely 
studied them in school.

They were penned by Emma Lazarus in 1883, her 
tome inspired by the Statue of Liberty, which wasn’t even 
dedicated until three years later.

The most famous lines of her poem, “The New Co-
lossus,” are, oh, so familiar: “Give me your tired, your 
poor, your huddled masses yearning to breathe free, the 
wretched refuse of your teeming shore.   Send these, the 
homeless, tempest-tossed to me, I lift my lamp beside the 
golden door.”M
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Weekly Photo Winner: 
KATHLEEN GUILL

The Altus Times

Daily, Semi- and Tri-Weekly Photo Winner: 
BILLY HEFTON

Enid News & Eagle

OGE Energy Corp. provides monthly winners with a $100 check and 
certificate. Sweepstakes winners receive $200 and a plaque from OGE.  

Contest open to staff at OPA Legal Newspaper and General News Media 
members, as well as OPA Individual members.  

Complete contest rules and online submission form  
available at okpress.com/oge-photo-contest. 

View winning photos at okpress.com/ 
oge-photo-contest 

FEBRUARY 2025 WINNERS All entries judged by members of the Oklahoma Journalism Hall of Fame 

Editorial Winner: 
KIM POINDEXTER

Tahlequah Daily Press

Stitt correct to speak out  
against Walters

The honeymoon between Gov. Kevin Stitt and State 
Superintendent Ryan Walters is apparently over – if 
“honeymoon” is the correct word to use, when it comes to 
state-level politicians.

Stitt likely has motives other than the welfare of 
Oklahoma’s school children when he says he’s had 
enough of Walters’ drama. But whatever his rationale, 
Stitt’s denouncing of Walters’ use of children as “political 
pawns” is laudable, and everyone with an email account 
or a phone should let him know that.

Oklahoma Natural Gas provides monthly winners with a $100 check and certificate. Sweepstakes winners receive $200 and a plaque from ONG.  
Contest open to staff at OPA Legal Newspaper and General News Media members, as well as OPA Individual members.  

Complete contest rules and online submission form available at okpress.com/ong-contest. 
Views expressed in winning columns and editorials are those of the writers and don’t necessarily reflect the company’s opinions.

Read winning columns and editorials at okpress.com/ong-contest

http://okpress.com/oge-photo-contest
http://okpress.com/
http://okpress.com/ong-contest
http://okpress.com/ong-contest

